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Note: This documentation is work in progress and far from finished. New sections will be added in the near future.
Whenever questions or feedback is received from end users, we’re trying to update this documentation on the fly. So
don’t hesitate to contact us, whenever you run into problems.
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CHAPTER

ONE

INTRODUCTION

Note: This documentation is work in progress and far from finished. New sections will be added in the near future.
Whenever questions or feedback is received from end users, we’re trying to update this documentation on the fly. So
don’t hesitate to contact us, whenever you run into problems.

The ESDL MapEditor is a map based editor for energy systems or energy transition scenarios. It is fully based on the
Energy System Description Language (ESDL).

It provides the following functionality:

• Draw an energy system scenario by dragging and dropping energy assets on a map

• Connect components, set typical component characteristics (installed power, efficiencies, costs)

• Attach power or energy profiles to assets (demand and production profiles)

• Set control strategies (specifically needed for ESSIM simulations)

• Query external ESDL data sources, for example for solar or wind potential

• Visualize WMS layers with information that can be used to define your scenario

• Convert shapefiles into ESDL assets

• Query the boundary service for area borders (provinces, municipalities)

• Visualize results of simulations on the map (KPI dashboards, load animations, color areas based on KPI out-
comes, load duration curves)

3
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CHAPTER

TWO

THE ESDL MAPEDITOR USER INTERFACE

Once you log in into the ESDL MapEditor, you will see a user interface as shown in the following picture:

The different components will be explained in the table below
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Number Description
1 Top level menus
2 Button to get information stored in the Energy Data Repository (EDR)
3 Asset draw select tool
4 Line draw select tool
5 Area select; determines to which ESDL area assets are being added
6 Logout button
7 Layer control
8 Zoom buttons
9 Create screenshot of current view
10 ESSIM simulation controls
11 Place notes on the map
12 Draw assets
13 Edit and remove assets
14 Animation toolbar
15 Asset draw toolbar
16 Shows the coordinates (lat/lon) of the mouse pointer on the map

2.1 Top level menus

2.1.1 File menu

Menu item Description
New ESDL Start with a new empty energy system. Remove all current ESDL files loaded.
Load ESDL Load an ESDL file from your local file system. Remove all current ESDL files loaded.
Import ESDL Import an ESDL file from your local file system. This ESDL will be added to the list of loaded

ESDLs in the layer control section (7).
Save ESDL Save the currently selected ESDL to your local file system.
Load from
ESDL drive

Load or import an ESDL file from the ESDL drive (ESDL cloud storage).

Save to ESDL
drive

Save an ESDL to the ESDL drive.

Note: When you press ‘Save ESDL’ in the ESDL MapEditor, the behaviour is determined by your local browser
settings. Most browsers by default save files in the Downloads folder (on Windows at least). In your browser settings
you can specify to ask the user for a file location

6 Chapter 2. The ESDL MapEditor user interface



ESDL MapEditor

2.1.2 Edit menu

Menu item Description
ESDL table editor Opens the ESDL table editor, allows to edit attributes of multiple assets of same type
ESDL browser Opens the ESDL browser, a low level ESDL editor (advised for advanced users only)
Energy carriers Allows to add, edit, remove carrier information
Sectors Allows to add sectors
Environmental pro-
files

Allows to add all kind of environmental profiles (outside temperature, pressure, soil temper-
ature, . . . )

Shapefile converter
Search assets Allows to search for assets based on ID, name and let map zoom into this assets

2.1.3 Services menu

Menu item Description
Energy system statistics
External ESDL services
Get boundary information
ESSIM simulation
Load animation
ESDL compare
ESDL merge

2.1.4 View menu

Menu item Description
Refresh view Force the MapEditor UI to refresh
WMS layers Allows to visualize WMS layers in the MapEditor
Show/hide animation toolbar Show or hide the animation toolbar - for controlling the load animation
Show/hide asset draw toolbar Show or hide the asset draw toolbar - for quickly adding certain assets
Show/hide services toolbar Show or hide the services toolbar - for quickly calling certain services
Show/hide KPIs Show or hide KPI window
Clear simulation results Removes all kind of results from the UI (simulation results, validator feedback
Settings Settings for the MapEditor and its plugins

2.1.5 Help menu

Menu item Description
Documentation Opens this documentation website
About Shows the version of the ESDL MapEditor and some links for installing it

2.1. Top level menus 7
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2.2 Layer control

The layer control is split into two sections:

• Base layers

• ESDL layers

The base layers section allows you to choose the backgorund of the map, either openstreetmap (the default), google or
no map. The latter one can be used for schematic diagrams where the physical location is not important.

In the ESDL layer section you will find one item for each ESDL loaded in the MapEditor. The ESDL information is
separated in different layers that can each be shown or hidden. See the table below for a detailed description of the
different ESDL sub layers.

Layer Description
Area Layer showing the area boundaries
Assets Layer showing all ESDL assets
Connections Layer showing logical connections between assets
Buildings Layer showing building geometries
Potentials Layer showing energy potential information
KPIs Layer showing KPIs
Simulation results Layer showing simulation results, like animation of loads
Notes Layer showing the notes

8 Chapter 2. The ESDL MapEditor user interface
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THREE

ESDL - ENERGY SYSTEM DESCRIPTION LANGUAGE

Basic explanation

Link to https://energytransition.gitbook.io

9
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FOUR

BASIC TASKS IN THE ESDL MAPEDITOR

4.1 Creating an energy system description

When you log into the ESDL MapEditor for the first time, you start with an empty energy system description. You can
then start drawing your energy system. At any moment in time you can choose ‘New ESDL’ from the ‘File’ menu to
start with an empty energy system again.

You are asked to fill in the following information:

• Energy system name

• Energy system description

• Energy system instance name

• Top-level area name

After filling in those fields, an example structure like shown below will be created in memory. ESDL energy assets (or
other sub areas) can then be added to the top-level area to model a certain use case.

11
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4.2 Adding assets, areas and potentials

Energy assets are the core components of an ESDL energy system description. Energy assets can be subdivided into 5
different types, the so called ESDL capabilities.

The following table shows some examples of each capability with its MapEditor icon:

12 Chapter 4. Basic tasks in the ESDL MapEditor
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ESDL asset types Example icons ESDL asset examples

Producer WindTurbine, GeothermalSource, Import

Consumer HeatingDemand, Export, ElectricityDemand

Conversion PowerPlant, HeatPump, GasHeater

Storage Battery, ATES, WaterBuffer

Transport ElectricityCable, Transformer, Pipe

Areas and potentials can only be added using the asset draw select tool, but there are multiple ways to add assets to the
map:

• Via the asset draw select tool (nr 3. in this picture)

• Via the asset draw toolbar (nr. 15 in this picture)

• Using templated assets from the Energy Data Repository

4.2.1 Adding assets, areas or potentials via the asset draw select tool

Adding assets, areas or potentials is done via the asset draw select tool located in the middle of the top menu bar.
Actually it is split into two separate select tools to speed up drawing pipes and cables.

The left select tool (nr. 3 in this picture) contains 7 groups:

• a group for ‘Non EnergyAssets’, with Area, Building and AggregatedBuilding

• 5 groups for Producer, Consumer, Storage, Transport and Conversion assets

• a group with all ‘Potentials’

By selecting one of the options out of this list, the user starts drawing this on the map immediately.

Another relevant UI part are the draw controls (nr. 12 in this picture):

4.2. Adding assets, areas and potentials 13
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From top to bottom they represent drawing a line, drawing a polygon, drawing a square and drawing a point (or marker).

Each asset (and area and potentials too) has a default ‘shape’ on the map. At the moment these defaults are:

• Polygon: Area, PVPark, WindPark

• Line: Pipe, ElectricityCable

• Point: everything else

You can switch the shape using the draw controls on the left, before clicking on the map. So for example, if you select
a Transformer asset from the list, by default the ‘marker draw tool’ is selected. If you first click on the ‘polygon draw
tool’ and then start drawing on the map, a Transformer asset can get a polygon geometry where the space taken on the
map by this transformer is represented in the ESDL data.

4.2.2 Drawing pipes and cables

Pipes and cables can be drawn using the method above (by selecting Pipe of ElectricityCable in the long list of the left
select tool). To speed up drawing pipes and cables, we’ve added a second select tool specifically for pipes and cables.
If the user selects the ‘line draw tool’ from the draw controls on the left, the right part of the select tool (nr. 4 in this
picture) determines if a pipe or a cable is drawn.

Note: ElectricityCables and Pipes can also be added as icons (with a point location) instead of lines. This can be
useful if your model requires to add properties of a cable or pipe (like capacity or diameter), but you don’t know the
exact trajectory of the cable or pipe.

14 Chapter 4. Basic tasks in the ESDL MapEditor
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4.2.3 Adding assets via the asset draw toolbar

Adding assets using the Asset draw toolbar is the most convenient way of doing this. It is fully user configurable and
adding assets is just a matter of clicking once on the icon of the asset on the toolbar and then clicking on the map (once
or as many times as you like). The default shape can again be changed before the actual drawing is started.

In this section the configuration options of the asset draw toolbar are described in more detail.

4.2.4 Adding assets using the Energy Data Repository

Adding templated assets from the Energy Data Repository (EDR), can be done by clicking on the ‘EDR assets’ button
at the top (nr. 2 in this picture). It’s described in more detail here

4.3 Adding assets from the Energy Data Repository

The Energy Data Repository is an online database with ESDL data. The Energy Data Repository (EDR) contains 3
sections:

• Assets: Asset data with technology and cost parameters

• Profiles: Standard profiles

• Key figures: Key figures, like a list of energy carriers, or the sector overview according to the SBI

At the moment the MapEditor allows to add assets to the map based on the EDR contents. To add an assets from the
EDR, click the ‘EDR assets’ button:

The following dialog appears:

4.3. Adding assets from the Energy Data Repository 15
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The dialog contains two drop down lists. The first one can be used to filter on a specific type of asset. The second
drop down list actually determines which asset information is loaded from the EDR. Press the ‘Select’ button to start
with the process of adding the asset to a specific location. See the Adding assets, areas and potentials section for more
information.

16 Chapter 4. Basic tasks in the ESDL MapEditor
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4.4 Editing asset properties

A created ESDL asset has a number of attributes (properties) that can be changed by a MapEditor user. The easiest way
to change attributes of an ESDL asset is to click on the created asset. For example, to edit a HeatingDemand, (left)click
on the HeatingDemand icon (nr. 1). This action opens a side menu with all asset parameters that can be changed (nr.2).
The side menu contains different attribute categories, namely:

• Basic attributes

• ESSIM attributes

• Advanced attributes

• Ports

• Cost information

Each of these categories contains different assets that can be relevant for different simulation tools.

4.4. Editing asset properties 17
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To edit attributes relevant for an ESSIM simulation, click on the ESSIM attributes category. This action opens a list of
attributes relevant for ESSIM simulation tool. The same principle applied to other categories as well.

To change the HeatingDemand’s power and set it to 50MW, enter 50M (power is always specified in Watts) in the power
field (nr.1). To save the changes, click on the Save button (nr.2).

18 Chapter 4. Basic tasks in the ESDL MapEditor
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4.4.1 Editing asset properties using ESDL browser

The parameters of an ESDL asset can also be changed through the ESDL browser. This provides more details and
ability to navigate through each (connecting) element individually. To change the power parameter through the ESDL
browser, right-click on the HeatingDemand (nr.1) and select Edit (nr.2).

To change the HeatingDemand’s power attribute, enter a new value for power (nr.1) and close the window (nr.2). The
changes are saved automatically.

4.4. Editing asset properties 19
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4.5 Moving assets and changing asset shapes

Handling assets depends on its shape on the map. Assets represented as a marker, line or polygon can be moved or
changed shape using the edit and remove controls at the left side of the map (nr. 13 in this picture):

By clicking on the upper icon, you start the edit mode. All assets can then be moved. The edit mode must be confirmed
by pressing the ‘save’ button.

Note: Assets represented as a marker, with a point location can be moved by just dragging the icon to another location.

4.5.1 Moving or changing a line

A line in edit mode, looks like this:

You know have three options:

• By dragging the single gray handle, the line can be moved as a whole

• By dragging the vertex handles, the line vertex can be moved

• By dragging the handle in the middle of an edge, an extra vertex will be created

20 Chapter 4. Basic tasks in the ESDL MapEditor
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4.5.2 Moving or changing a polygon

A polygon in edit mode, looks like this:

You know have three options:

• By dragging the single gray handle, the polygon can be moved as a whole

• By dragging the vertex handles, the polygon vertex can be moved

• By dragging the handle in the middle of an edge, an extra vertex will be created

4.6 Removing assets

Assets can be removed in multiple ways:

• Using the edit and remove controls (nr. 13 in this picture):

By clicking on the lower icon, you start the remove mode. All assets can then be removed by clicking them. The
remove mode must be confirmed by pressing the ‘save’ button.

• By right clicking on an asset icon (or on the line) and selecting ‘Delete’ from the context menu

4.6. Removing assets 21
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4.7 Connecting assets

ESDL knows the concept of ports and connections to connect assets. Ports exist in two types (by design, see this article
for more detailed information):

• InPort: port that is mainly used for incoming flow, current or energy

• OutPort: port that is mainly used for outgoing flow, current or energy

An InPort is visualized as a gray square to the left on an asset, an OutPort is visualized as a black square to the right of
an assets. InPorts can only be connected to OutPorts and the other way around.

The amount and type of ports the MapEditor attaches to an asset when the user adds an asset to the map, depends on
the view mode. The standard behaviour is as follows (for drawing ‘single-line systems’):

• Producer: 1 OutPort

• Consumer: 1 InPort

• Storage: 1 InPort

• Conversion: 1 InPort and 1 OutPort

– There are two exceptions to this rule, for the CoGeneration types (CHP and FuelCell): They’ll get 1 InPort
and 2 OutPorts

• Transport: 1 InPort and 1 OutPort

22 Chapter 4. Basic tasks in the ESDL MapEditor
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If you switch the view mode to ‘CHESS’, this behaviour changes to (for drawing ‘double-line systems’):

• Producer: 1 InPort and 1 OutPort

• Consumer: 1 InPort and 1 OutPort

• Storage: 1 InPort and 1 OutPort

• Conversion: 1 InPort and 1 OutPort

• Transport: 1 InPort and 1 OutPort

– There are two exceptions to this rule, for the Transformer and HeatExchange: They’ll get 1 InPort and 1
OutPort for the primary side and 1 InPort and 1 OutPort for the secondary side

– You can manually add more ports if required.

4.7.1 Connecting assets by using the ports

There are two ways to connect assets:

1. You can connect the assets directly by connecting a port from one asset to the port of another asset. Make sure
the ports are different: an InPort can only be connected to an OutPort and vice versa.

You can connect one InPort to multiple OutPorts and vice versa.

• To connect assets in the MapEditor, click with the mouse on a port and a dotted line appears that can be directly
connected to another port (of a different type). To connect click on that port and the connection is made.

• When two ports are connected a dotted line between the assets is shown. The color of that dotted line is an
visualisation of the carrier of the Ports and can be configured via the View menu -> Carriers.

• Ports without carriers have a dark gray color.

2. You connect them by using a so called Conductor. Currently there are two types of Conductors: a Pipe and an
ElectricityCable.

To ease the creation of networks of pipes or cables, there is a shortcut in the MapEditor to directly connect
conductors to assets (e.g. it makes the connection between the asset and the pipe/cable automatically).

To do that, use the line tool on the right side of the screen to start drawing a pipe or a cable. Which one is drawn
is shown at the top of the page and can be changed during drawing.

4.7. Connecting assets 23
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• To directly connect a conductor to an asset click on the port you want to connect and draw the pipe. Make
sure you selected the line tool in the draw toolbar on the left. You can add bends while drawing the Con-
ductor by clicking on the map.

– To connect directly to another asset, click the corresponding port of that asset. The MapEditor filters
out only ports of the correct type, e.g. when start drawing on an InPort (gray square), only OutPorts
(black squares) are shown.

– To end the pipe/cable somewhere else on the map, click the last point of the line again to end drawing.

If you quickly want to connect two assets, you can also the Ctrl key: do Control+Click on a port. It will
then start to draw a port/cable directly, without selecting the line draw button from the toolbar first.

4.7.2 Keyboard shortcuts

There are a few keyboard shortcuts to speed up drawing cables and pipes:

• Press the Ctrl-key before clicking a port (Ctrl + click), will directly turn on pipe/cable drawing.

• Press ‘c’ to draw a cable,

• Press ‘p’ to draw a pipe,

• Press ‘a’ to draw the last selected asset in the menu bar directly.

Make sure the map has focus to capture these shortcut keys, e.g. by clicking on the map itself first if that is not the case.

4.8 Removing a connection

A connection can be removed in two ways:

• By hovering with your mouse over a connection (the connection is then changing from a dotted to a straight line),
then right clicking on this connection and then selecting ‘Delete connection’ from the context menu

24 Chapter 4. Basic tasks in the ESDL MapEditor
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• By using the asset properties dialog

4.8. Removing a connection 25
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The following steps must be taken:

– Click on an asset to open the asset properties dialog

– Open de Ports sections (1)

– Find the port and expand the conncetions list (3) by clicking on the plus sign (2)

– Remove the connection by clicking on the bin icon (4) behind the connection

4.9 Defining and setting energy carriers

ESDL energy assets produce, consume, store, or convert different energy commodities and carries such as, for example,
gas (natural gas, hydrogen etc.), electricity, or heat. These commodities and carriers are assigned to connections
between energy assets.

In this basic scenario, two Commodities exist: gas (imported from an external system) and heat (as a result of GasHeater
conversion). To add an energy Commodity, mouseover the Edit menu item and click on Energy carriers. . . (see figure
below). A pop-up menu opens with a list of energy Carriers and Commodities that can be added and configured.

Click on the Carrier type dropdown menu (nr.1), and select Gas Commodity (nr.2).

Give it a descriptive name (e.g. Natural Gas) (nr.1) and leave the other fields blank. To save the changes, click on Add
(nr.2).

26 Chapter 4. Basic tasks in the ESDL MapEditor
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The created Gas Commodity (Natural Gas) is shown on the pop-up window, along with the color that will be used to
visualize the connections that have this commodity. The color of the commodity can be changed.

Repeat the same process to create Heat commodity.

4.9.1 Assigning energy commodities to asset connections

Energy carriers and commodities created in the previous steps are assigned to connections between ESDL energy assets,
i.e. to their InPorts and OutPorts. To assign the natural gas commodity to Import’s OutPort asset, right-click on Import
and select Set carrier.

4.9. Defining and setting energy carriers 27
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A pop-up window opens with a list of created energy commodities (Natural Gas and Heat, in this example). To assign
Natural Gas to Import asset, click on Natural Gas in the list of carriers. The window automatically closes, and Natural
Gas is assigned to the OutPort of Import, and the InPort of GasHeater, as there already exists a connection between
these two ports.

The connection between the Import and GasHeater is colored in red (the color assigned to Natural Gas commodity),
indicating the assigned commodity.

Repeat the same process to assign Heat commodity to HeatingDemand. This will assign Heat commodity to Heat-
ingDemand’s InPort, and to GasHeater’s OutPort. Assigned commodities can be seen by clicking on an asset and

28 Chapter 4. Basic tasks in the ESDL MapEditor
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navigating to the Ports group, as shown below for GasHeater.

4.10 Assigning profiles

Profiles in ESDL are attached to assets’ InPorts and OutPorts. MapEditor offers a list of pre-defined profiles, such as
standard NEDU profiles, that a user can choose from.

To attach a heat demand profile to a HeatingDemand, right-click on the asset and choose “Set profile of InPort”.

A pop-up menu appears with different parameters for a profile. The parameters that need to be set for a profile include:

• Profile class

• Value

• Type

• Quantity and Unit

These parameters can be selected and entered in the fields below.

4.10. Assigning profiles 29
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In this example, the yearly heating demand will be set to 20 kWh. The Profile class dropdown menu offers a number of
different types of profiles, some pre-loaded in MapEditor, others from EDR (Energy Data Repository), but also custom
profiles. To choose a heating demand profile of a typical Dutch neighborhood, select NEDU G1A profile class from
the Profile class dropdown menu.

To set the value of 20 kWh heating demand per year, enter 20 in the Multiplier field (nr.1), and choose Energy in kWh
from the Quantity and Unit dropdown menu (nr.2). To save the changes, click the Add button (nr.3).

30 Chapter 4. Basic tasks in the ESDL MapEditor
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ESDL MAPEDITOR FEATURES

5.1 Asset Draw Toolbar

The asset draw toolbar is a toolbar that eases the selection of frequently used assets. Users can configure the asset draw
toolbar according to their needs.

5.1.1 Show and hide the Asset Draw Toolbar

In the ‘view’ menu you can choose to show or hide the Asset Draw Toolbar

31



ESDL MapEditor

5.1.2 Settings at startup

In the application settings window, in the section ‘UI Settings’ you can select what the initial status of visibility of the
Asset Draw Toolbar is when you log in into the ESDL MapEditor. You can show the application settings window by
selecting ‘settings’ in the ‘view’ menu.

5.1.3 Configuring the Asset Draw Toolbar

In the application settings window, in the section ‘AssetDrawToolbar plugin’, subsection ‘Standard assets’ you can
determine which assets you want to appear in the toolbar. These settings depend on the view mode. The view mode
can be selected with the select box at the top of the configuration window. This allows you to have different assets
visible in the toolbar when you’re drawing a detailed design of a district heat network, than when you’re designing a
more high level energy system. In the below picture the view mode ‘standard’ has been selected. You can move assets
from left to right to let them appear in the toolbar and from right to left to let them disasppear.

32 Chapter 5. ESDL MapEditor features



ESDL MapEditor

In the subsection ‘EDR assets’ the same can be done for assets from the EDR that are frequently used.

5.2 Profile manager

In MapEditor, different profiles can be added to energy assets’ In and OutPorts. A user can choose a profile from the
list of pre-defined EDR or MapEditor’s DB profiles (such as standard NEDU profiles), but also define and choose their
own profiles. Adding custom profiles, as well as deleting them, is done through the Profile manager.

5.2.1 Profiles plugin

To access the Profile manager, click on View menu item on the menu bar (nr.1), and go to Settings (nr.2).
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Profiles plugin allows a user to manually create and add a profile. To access this feature, click on Profiles plugin
(nr.1) and fill in the fields on the window (nr.2). Using these fields, a profile can be created using data from different
InfluxDBs.
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Furthermore, by selecting a profile from the dropdown menu (nr.1), a user can visualize existing (uploaded) profiles,
and check their parameters such as database name, measurement, start and end date, and others.

5.2.2 Uploading custom profiles

To upload custom profile, first go to the Profile manager as shown above. Then, navigate to Profiles plugin and click
on Upload profiles (nr.1). For it to be recognized by MapEditor, a custom profile should be provided as a CSV file that
adheres to a certain format. The formatting rules are listed at the bottom of the window (see the green box). Profiles
can be stored in different groups, depending on the access rights. For example, a user can define a personal profile
(accessible only by the user that defined it), a profile related to a certain project (accessible by users working on the
same project), or a profile that will be stored to EDR or MapEditor’s database (accessible by everyone). To upload a
custom profile, choose the appropriate access group from the dropdown menu (nr.2).
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An example CSV file used to create a custom profile is shown below.
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In this example, a custom profile will be added to the Personal profiles group (nr.1). Select whether the profile values
should be averaged or summed over time (depending on the unit the values represent) (nr.2), and click on Select files
(nr.3) to select the desired files to be uploaded.

If a profile is successfully uploaded, a message is displayed on the window.

Once a profile is uploaded, it can be added to an asset’s port by selecting it from the Profile class dropdown menu.
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5.2.3 Deleting profiles

To delete an uploaded file, navigate again to Profiles plugin by clicking on View menu item on the menu bar (nr.1), and
going to Settings (nr.2).
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Select Delete profiles (nr.1), scroll down to the profile created above (nr.2), and click on Delete profiles (nr.3).
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5.3 Boundary service

5.4 Building information

Whenever you load an ESDL file, with buildings in it with their geometry (for example using the ESDL BAG service),
the MapEditor will visualize these buildings on the map. It will try to find three specific attributes of these buildings,
namely building year, building area and building type. The buildings will be colored according to these attributes. You
can choose the attribute that should be used for coloring in the dropdown menu at the top op the legend.

5.4.1 ESDL BAG service

5.5 Building editor

MapEditor allows modeling a building as a collection of different energy assets. This can be useful for different pur-
poses, not only for a better visual representation, but also for analyzing the results of the simulations (depending on the
simulator used). An ESDL Building is not an energy asset, which is why energy assets should be added to it separately.
To add energy assets to a created Building, right-click on the building and select Building ESDL contents.
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A pop-up building menu opens with menus for creating, deleting and editing energy assets. Note that all the assets
created for the Building have to be created using the Building menu. Create an HConnection (heat connection) and
a HeatingDemand using the pop-up menu bar. The HConnection will be used to connect the Building to the heat
production energy assets outside the building.

To connect the HeatingDemand to the HConnection, connect the two assets the same way assets outside the Building
are connected.
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Connecting an asset within the Building with the one outside the Building has to be done using the ESDL browser. To
connect HConnection to the GasHeater outside the building, right-click on the HConnection and select Edit.
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In the ESDL browser, navigate to Port and click on In of HConnection.

To select the port that HConnection’s InPort should be connected to, navigate to Connected To and click on . . . next to
it.

Select Out of GasHeater from the dropdown menu (nr.1), and click on Next (nr.2). The two assets are now connected.

To add the Carrier to the connection, navigate to Carrier of the port, and click on . . . next to it.
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Select Heat from the dropdown menu (nr.1), and click on Next (nr.2). The Carrier is now assigned to the connection.
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5.6 Visualizing KPIs

KPIs in ESDL can be attached to different objects:

• the top level area

• sub areas

• assets

5.6.1 Top level area KPIs

KPIs attached to the top level area are visualized using a dialog with graphs.
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5.6.2 Sub area KPIs

KPIs attached to areas that are sub areas of the top level area are visualized as follows:
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• In the legend at the bottom right you can choose the KPI that is used for coloring the areas

• If you hover over the areas, all KPIs attached to that area are shown as a table in the tooltip

5.6.3 Asset KPIs

Asset KPIs are currently not visualized

5.7 Comparing scenarios

5.8 Notes

To document certain design decisions (or any other remarks), users can add notes to their ESDL file. To create a note,
click on the Notes icon on the sidebar.

After clicking the Notes button, add a note at a desired position on the map by clicking on that position. Clicking on a
note itself (nr.1) opens a pop-up window to add a note title and text (nr.2). Title and text of a note can be edited to give
a description of, for example, a design decision. Author and date are automatically filled in based on the logged in user
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and the current date and time. To save a note, click on the Save button. To discard the changes, click on the Discard
button. (nr.3)

Hovering over a note on the map shows the title and the text of a note.

To delete a note from the ESDL, right-click on a note and select Delete.
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5.9 WMS layer data

The ESDL MapEditor provides basic functionality for adding WMS layers. This information will be shown on the map
and can then be used as input information to design your energy system. WMS layers can be hosted by any external
server or you can install your own ARCGIS server or use the open source geoserver.

WMS layers can be organized per project or for personal use only.

5.9.1 Show WMS layers on the map

From the ‘View’ menu, select ‘WMS layers’

The following dialog will open:
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Click any layer from the list to visualize the information on the map
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5.9.2 Adding new layers

To add a new layer, the following information must be filled in:

• Description: Name of the layer that is used in the list with all WMS layers

• URL: URL of the server where the WMS layer is hosted. See example configurations for the format

• Layer name: Name of the layer on the server that needs to be visualized

• Legend URL (optional): URL of the legend image that belongs to the layer

• Add to group: To determine where this new layer will be added

Click ‘Add layer’ button to save the layer configuration.

Example configurations are:

• Example layer from the ‘Nationaal Georegister’:

– Description: AHN2 5 meter

– URL: http://geodata.nationaalgeoregister.nl/ahn2/wms?

– Layer name: ahn2_5m

– Legend URL: -

• Example layer from the ‘Warmte atlas’

– Description: LT_WarmteBronnen_ECW

5.9. WMS layer data 51

http://geodata.nationaalgeoregister.nl/ahn2/wms


ESDL MapEditor

– URL: https://rvo.b3p.nl/geoserver/WarmteAtlas/wms?

– Layer name: LT_WarmteBronnen_ECW

– Legend URL: -

• Example layer from Thermogis

– Description: Thermogis layer 1

– URL: http://www.thermogis.nl/arcgis/services/thermogis/ThermoGIS_WMS/MapServer/WmsServer?

– Layer name: 1

– Legend URL: -

• Example layer from PICO

– Description: PICO Hoogspanningsnet 2018

– URL: https://pico.geodan.nl/cgi-bin/qgis_mapserv.fcgi?DPI=120&map=/usr/lib/cgi-bin/projects/
Hoogspanningsnet_2018.qgs

– Layer name: Hoogspanningsnet_2018

– Legend URL: https://pico.geodan.nl/cgi-bin/qgis_mapserv.fcgi?DPI=96 &map=/usr/lib/cgi-
bin/projects/Hoogspanningsnet_2018.qgs&request=GetLegendGraphic&service=WMS &itemFONT-
SIZE=7&format=png&layertitle=false&layer=Hoogspanningsnet_2018

5.9.3 Deleting layers

Right click with the mouse on a layer name and click ‘Delete layer’
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5.10 Shapefile import

5.11 Animation of loads over time

5.12 Configuring external ESDL services

5.13 Workflow definition
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SIX

EXTERNAL ESDL SERVICES

6.1 Calliope - Spatial optimization

6.2 ESSIM - The Energy System Simulator

6.3 ETM - The Energy Transition Model

6.4 PandaPower - Loadflow calculations

6.5 PICO

6.6 VESTA

6.7 EPS - Energy Potential Scan
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SEVEN

EXAMPLE WORKFLOWS

7.1 Exploring spatial possibilities for large scale wind and solar

One of the applications provided by the PICO model developed by Geodan, is to gain insight in the spatial possibilities
for large scale wind and solar energy production. The PICO model can be queried for this potential, with several
constraints as input that can be given by user. The results in ESDL can be visualized in the ESDL MapEditor.

Note: This page describes the steps for exploring the spatial possibilities for large scale wind. You can follow exactly
the same steps if you select the ‘Get PICO solar field potential’ service in step 2.

This workflow can be divided in the following steps:

1. Click ‘External ESDL Services’ in the Services menu

2. Select ‘Get PICO wind potential’
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3. The following information is displayed
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4. Fill in the required input parameters

• We select the province of Drenthe

• We want to know what the potential is, if we require a minimal distance of 500 meters between the
wind turbines and the built environment

• We don’t want to include areas that have been marked as ‘nature’ and do want to include any agri-
cultural area
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5. The result will look like the following picture. Each hexagon is a possible location for a wind turbine.
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6. One possible option is to select an ‘ETM WindTurbine on Land’ asset from the Energy Data Repository (see
Adding assets from the Energy Data Repository for more information).
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7.2 Exploring rooftop PV panels potential

One of the applications provided by the PICO model developed by Geodan, is to gain insight in the potential for rooftop
PV panels. Based on internal calculations the model can be queried for the potential on roofs of 5 different orientations:

• Roofs facing north

• Roofs facing east

• Roofs facing Ssouth

• Roofs facing west

• Flat roofs

There are two possible ways to use this service:

• Via the ‘External services’ menu

• Via the context menu of an area on the map
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7.2.1 External services menu

This workflow can be divided in the following steps:

1. Go to ‘Services’ menu and select ‘External ESDL Services’. Select ‘Get PICO rooftop solar potential’ from the
list

2. The service can be queried for 3 different geographical scopes:

3. As an example, select ‘Municipality’ and choose ‘Hengelo’. Press the ‘Run Service’ button. The following result
will load.
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5. Continue here

7.2.2 Via the area context menu

1. If you have an already loaded energy system (and the area attributes have been formatted in the right way), you
can right click on an area and select ‘Query Rooftop PV Potential’.
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2. A dialog opens where you can select to only query the potential for the selected area or for all areas in the energy
system.

3. If you choose to query for all areas, the result looks like
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4. Continue here

7.2.3 Exploring potential values

1. When you right click on a building on the map, a context menu appears

2. Click ‘Building ESDL contents’ to open the building editor
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3. Right click on one of the icons for the solar potential (SP)

4. Click on ‘Edit’ to open the ESDL browser and inspect the information.
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7.2.4 Converting potential to actual installations

The last functionality is to convert (part of) the potential to installed capacity of PV installations.

1. Right click on an area, and select ‘Use Rooftop PV Potential’
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2. At the moment you can fill in one percentage for all orientations and apply this to this area or all areas

3. If you open the building editor again, the result looks like this. By right clicking on an icon for a PV installation
and selecting ‘Edit’ from the menu, values can be inspected.
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Note: ESDL: The produced energy in kWh is connected as a SingleValue profile to the OutPort of the PVInstallation
asset. Other models, like for example the Energy Transition Model, know how to handle this information and are able
to take these values into account.

7.3 Importing search areas

Maps with information about search areas where large scale onshore wind and solar parks development should be
focussed, are often used as an input for a certain energy system scenario. If this information is already hosted in for
example an ARCGIS server environment, these layers are often offered as a WMS service.

If you have one or more files on your filesystem, you need to host these files one way or the other. GIS files of many
different types can be hosted in a separate Geoserver instance. Examples are shapefiles, geojson files and geopackage
files. The MapEditor has no interface for uploading these file types, so you have to use the management interface of
your Geoserver instance.

With the hosted versions of the maps, you can follow the section about WMS layer data to visualize the information on
the map.

70 Chapter 7. Example workflows



ESDL MapEditor

7.3. Importing search areas 71



ESDL MapEditor

72 Chapter 7. Example workflows



CHAPTER

EIGHT

FUNCTIONAL ARCHITECTURE
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NINE

INDICES AND TABLES

• genindex

• modindex

• search
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